
 

The update history of VisualFEA can be viewed by the following procedure. 
 1) Run VisualFEA 
 2) Select "Update History" item from "Help" menu 
 3) Check the updated items from "Update History" dialog. 
Use the horizontal or vertical scroll bar if necessary. 

 

      =========================       

      VisualFEA  Update History       

      =========================       

 

  No.    Version    Date(Y.M.D)      Update Contents 

------   -------   ------------  -------------------------------------------------------------------------------------------- 

   124     5.14    2022. 6.28.    Cross clipping plane function 

   123     5.14    2022. 6. 2.    Improvement of functions creating fillets (line-line, line-circular arc, circular arc- circular arc 

   122     5.13    2022. 5.16.    Improvement of functions defining and assigning bounday conditions. 

   121     5.13    2022. 2.14.    Moification of "Grid System" function. 

   120     5.13    2022. 1. 9.    Moification of "DXF importing" function. 

   119     5.13    2021. 9. 6.    Moification of "Terrain Adjustment"dialog. 

   118     5.13    2021. 7.26.    New function of exposing the volume elements inside of 3D solid meshes using a clipping plane. 

   117     5.13    2021. 5.30.    Addtional new option of advancing front algorithm for triangular mesh generation. 

   116     5.13    2020. 6.20.    Automatic turning on/off grid. 

   115     5.12    2020. 2.10.    Excel output function. 

   114     5.12    2019. 1.28.    A new item, "Surface Selection Aid", is added to facilitate selections of surface meshes for Auto Mesh (Volume). 

   113     5.12    2018. 5. 1.    New function of cutting plane view. (Realtime rendering of cutting plane view of contour image) 

   112     5.12    2017. 4. 1.    OpenGL option is added for image rendering. 

   111     5.11    2016.10. 7.    New type of spring element, "Coupled Spring", is coupled with a compression or tension spring in perpendicular direction. 

   110     5.11    2016. 5. 9.    Automatic extension of grid planes 

   109     5.11    2016. 3. 4.    Improvement of shape funtion display 



   108     5.11    2015. 5. 8.    Improvement of time requirement for large mesh generation: mapping, extrusion, sweeping types 

   107     5.11    2015. 4.18.    Addition of "Continuous line" rendering option for vector display 

   106     5.11    2015. 4. 1.    Improvement of vector drawing option 

   105     5.11    2015. 3.29.    Addition of "Nodal mass (directional)" to the dynamic motion type 

   104     5.11    2015. 3.19.    Info tip for stress image of frame section 

   103     5.11    2015. 3.17.    Application of body force (acceleration) to nodes assigned with nodel mass.(Dynamic analysis only) 

   102     5.11    2015. 3.16.    Modification of dynamic motion data 

   101     5.11    2014.11.15.    New function of displaying frame diagrams on a separate frame diagram window 

   100     5.11    2014.10.25.    Improvement of elasto-plastic analysis of frame members using internal plastic hinges between nodal points 

    99     5.11    2014. 9. 5.    "Anti-aliasing" option for improved rendering of frame shading and contouring 

    98     5.11    2014. 8.29.    Representation of plastic hinges for frame models with elasto-plastic analysis 

    97     5.11    2014. 8.22.    Improvement of setting the diagram display options, and addition of the help items describing the options 

    96     5.10    2014. 8. 6.    Improvement of transparency shading 

    95     5.10    2014. 7.24.    Revision related to elasto-plastic analysis and geometric nonlinear analysis of frames 

    94     5.10    2014. 7.10.    Expansion of the image scaling range from (1/32 - 32) to (1/512 - 512) 

    93     5.10    2014. 7. 8.    Zoom in/out using the mouse wheel 

    92     5.10    2014. 6.18.    Capability of importing DXF data with 3DFACE, 3DSOLID and polyface mesh 

    91     5.10    2014. 5.02.    Improvement of importing external data with compatibility to DXF 12/14 

    90     5.10    2014. 4.14.    Revision of mesh carving and mesh operation process based on Delaunay algorithm 

    89     5.10    2014. 3.30.    Addition of a new option for 3D auto tetrohedronization: Delaunay algorithm 

    88     5.10    2014. 1. 6.    More rendering options in preference setting: normal vector interpolation, etc. 

    87     5.10    2013. 7.21.    Shadow casting over contour images 

    86     5.10    2013. 6.18.    Solid carving by surface primitives. Previously,solid carving was possible only by surface meshes 

    85     5.10    2013. 5.23.    Preference setting for the number of internal iterations to reduce residuals.  Preference -> Solver 

    84     5.10    2013. 5.17.    Addition of new load type. Linearly distributed load on a part of a frame element 

    83     5.10    2013. 5. 9.    Inclusion of uniform load type for moving loads 

    82     5.09    2013. 4.20.    Addition of new load type. Uniform distributed load on a part of a frame element 

    81     5.09    2013. 2. 8.    Consistent scale for contouring of frame member forces and stresses 

    80     5.09    2012.12.20.    Overall modification of the CBT functions (especially related to shape function) 

    79     5.08    2012. 7. 8.    Addition of Hyperelastic model 



    78     5.08    2012. 7. 6.    Addition of Duncan-Chang nonlinear elastic model 

    77     5.08    2012. 6.15.    Redering of the yield surface and mohr's circle for points on a cutting plane 

    76     5.08    2012. 6.1.    Tracing of bending moment and shear force diagrams for moving loads 

    75     5.08    2012. 5.15.    Realtime update of the stress contours while rotating the stress square coupled with a Mohr's circle diagram. 

    74     5.08    2012. 5.14.    New options of selecting surface meshes surrounding volume meshes.  "Outer surface only", "Intra surface only" 

    73     5.08    2012. 5.11.    New functions for object listview. Reservation of objects for future selection. Saving the list file with reserved object number. 

    72     5.08    2012. 5. 5.    Methods of enforcing nodal constraints. "Edit"->"Preference",->"Solver". Static condensation and penalty function. 

    71     5.08    2012. 4.19.    New function of displaying the min. and max. values. "Postpro"->"Nodal Value"->"Mark Min. Max. Node" menu item 

    70     5.07    2012. 4. 7.    Modification of "Assign" menu items 

    69     5.07    2012. 4. 4.    Addition of "Show Graph" item for dynamic motions 

    68     5.07    2012. 3.30.    Addition of "File" -> "Open Recent" menu item 

    67     5.07    2012. 3.27.    A new option for mesh carving. Carving surface meshes by surface primitives 

    66     5.07    2012. 3.12.    New function to rescale the model. "Edit" -> "Convert Coordinate" -> "Scale" 

    65     5.07    2012. 3.10.    Help button to display the data file format for dynamic load and dynamic motion time series 

    64     5.07    2012. 3. 5.    Instant indication of the internal force or moment directions at the cursor point for the displayed frame diagrams 

    63     5.07    2012. 1.10.    Mac OSX 10.7(Lion) version 

    62     5.07    2011. 9.14.    Mohr circle and yield surface functions for nonlinear load combination analysis 

    61     5.07    2011. 9.13.    Addition of uncouple solution mode for two phase problems 

    60     5.06    2011. 8.23.    Addition of a new output item: displacement incremental rate 

    59     5.06    2011. 7.31.    Selection of the color for line vector drawing 

    58     5.06    2011. 7.21.    Grid origin and min-max range setting by dialog input 

    57     5.06    2011. 7.19.    Option of setting the sampling line by node selection for curve plotting 

    56     5.06    2011. 7.16.    Simplified diagram option for 2-D and 3-D frame 

    55     5.05    2011. 6.12.    Mesh deformation 

    54     5.05    2011. 5.30.    Contour (factor of safety) adjustment for slope stability 

    53     5.05    2011. 3.14.    Addition of interactive control to Mohr's circle functions 

    52     5.05    2011. 2. 6.    Control of the protection key through local area network or internet 

    51     5.05    2010.11.22.    Time or square root time scale option for multi-step plotting of transient seepage or consolidation analysis 

    50     5.05    2010.11.15.    Automatic saving and retrieving the Contour setting  

    49     5.05    2010.11.12.    Addition of "Rainbow soft", "Hard","Strong" items to "Color" option in "Countour Display" dialog 



    48     5.04    2010.11.05.    Option of square time steps in "Solve" dialog for transient seepage or heat transfer analysis 

    47     5.04    2010.10.20.    Turning on or off the grid subdivision using "Grid Setting"dialog. Previousely done by using F1 - F10 keys 

    46     5.04    2010. 9.15.    Addition of "Beam Interface" element 

    45     5.04    2010. 9. 3.    Activation of traveling (moving) load for dynamic analysis 

    44     5.04    2010. 8. 8.    Addition of deflection to influence line items 

    43     5.04    2010. 7.14.    Option to display the resultant forces and the center line in moving load display 

    42     5.04    2010. 7.10.    Mathmatical notations in combined drawing of shear force and bending moment diagrams 

    41     5.04    2010. 7.06.    Option to set the number of segments for simulation of moving load 

    40     5.04    2010. 7.03.    Representation of the area enclosed by the influence line 

    39     5.04    2010. 6.21.    Option to specify the property set for meshes imported from a text file 

    38     5.04    2010. 6.13.    Option to set the number of curve segments for rendering the shaded image of the frame deformation 

    37     5.04    2010. 6.12.    Remove the limitation for the number of curves. (limited to 32767 curves in previous versions) 

    36     5.03    2010. 6. 9.    "Suppress Curvature Effect" for axial and shear force diagram (only bending moment dia. in prev. ver.) 

    35     5.03    2010. 5.18.    Addition of new element type. Frame element with tapered section (V5) 

    34     5.02    2010. 5. 3.    Assignment of spring elemens to nodes (previously, curves or surface meshes only). 

    33     5.02    2010. 4.30.    Addition of <Update history> item to <Help> menu. 

    32     5.02    2010. 4.27.    Double click assignment of dynamic motion. 

    31     5.02    2010. 4.18.    Display option of VisualFEA logo with wireframe rendering. 

    30     5.02    2010. 4.12.    Improved assignment of dynamic motion. 

    29     5.01    2010. 4.04.    Option of offseting the rigid body motions from the dynamic time history. 

    28     5.01    2010. 3.22.    Multi-step plotting of data values represented by frame diagrams. 

    27     5.01    2010. 3.14.    Improved algorithm for evaluation of plasto-elastic failure factor. 

    26     5.01    2010. 2.27.    Improving the speed of importing mesh from text file. (Option to skip the extraction of boundary surface mesh) 

    25     5.00    2010. 1.10.    Internet authentication of the program licence. 

    24     4.12    2009.12.26.    Adition of "Stress table by depth" option for defining the insitu-stress. 

    23     4.12    2009.12.11.    Evaluation of yield factor for a point on the yield surface or the stress path. 

    22     4.12    2009.12. 8.    Data probing of the yield surface or the stress path. 

    21     4.12    2009.11.13.    Moving or probing of the Phi plane in the elasto-plastic yield surface. 

    20     4.12    2009.11. 1.    Improvement of yield envelope including the bounding limit. 

    19     4.12    2009.10.25.    Addition of Hoek-Brown (elasto-plastic) model. 



    18     4.12    2009. 8.15.    New mesh option "Stick Mesh to Primitive". 

    17     4.12    2009. 7.30.    total stress mode and effective stress mode for contouring 

    16     4.12    2009. 7.15.    Contour scaling based on the values of the rendered part of the model. 

    15     4.12    2009. 7.10.    Addition of "Joint Interface" element. 

    14     4.12    2009. 6.22.    Zooming and panning of Mohr circle. 

    13     4.12    2009. 5.23.    Coupled analysis of sequentially stage models. 

    12     4.12    2009. 5.16.    Interactive adjustment of the light source with instantly refreshed rendering 

    11     4.12    2009. 5.10.    Definition of material properties as a function of the depth. 

    10     4.12    2009. 5. 8.    New option of shading and contouring overlaid with outline image 

     9     4.11    2009. 4.28.    Addition or deletion of control points on curves (spline,Bezier, polyline, etc.)  

     8     4.11    2009. 4.17.    Equation coupled solution of the displacement d.o.f. and excess pore pressure d.o.f.  

     7     4.10    2009. 4. 4.    Bond strength of embedded bar 

     6     4.10    2009. 3.29.    Data probing of a point on the contour image. 

     5     4.10    2009. 3. 1.    Funtions (popup,hiding,moving, etc.) related to captions in frame diagrams. 

     4     4.10    2009. 2.20.    Addition of adaptive mesh reshaping option for fire destructive modeling. 

     3     4.10    2009. 2. 3.    Consolidation analysis  

     2     4.10    2009. 1.22.    Functional improvement of elasto-plastic yield surface and Mohr Circle 

     1     4.10    2009. 1.10.    Windows 64 bit version 


